INFINITY ANALYZE for Mac — User Guide Release 6.3.1
Updated for Mojave OSX

Overview

The INFINITY ANALYZE for Mac (v6.2.0) enables direct control over an INFINITY camera, and provides an ability to
acquire frames, perform measurements, and add annotations to captured images, along with the capability to export
images to popular formats. This application requires an operating system of Mac OSX 10.7 (or greater). Note: changes
to file export behavior when using drag & drop have been introduced by the Mojave OSV version. Refer to the Image
Export section at the end of this document for important information.

Application layout

The INFINITY ANALYZE for Mac is a workflow-oriented application, providing capabilities on three separate screens, or
views. Different operations are possible on each of the three views, and switching between these views is easily
accomplished. The main method to switch between the views is to simply click on one of the three icons present in the
upper right corner of the application. In sequence, these button icons represent the Video View, Browser View, and
Process View.

The main operations available in each of the three views are summarized in this table.

Video View Browser View Process View
> Live preview from the camera > Built-in database storage of > Annotation tools
captured images
> Prefix / descriptions for » Thumbnail previews of each image | » Measurement tools (for calibrated
acquired images images)
> Saved Presets and calibration > Control over image Galleries > Image Export
> Camera exposure control > Sorting options
> White Balance > Image Export
> Extended camera controls

Double-clicking on any thumbnail image in the Browser View will result in the application switching immediately to the
Process View with the selected image open for manipulation.

Switch between the three Views by clicking on the icons in the upper right of the Application window.
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Video View

The application launches with the Video View being displayed, and the camera’s live preview showing. The three

buttons to switch between views are visible in the upper right corner. In the top center of the display there is a camera

status indicator showing the elapsed time since the application was launched. In the upper left corner, the Camera icon

is available to acquire an image from the camera using the current settings. The Magnifying Glass icon can be clicked to

provide a quick preview of the most recently captured images. The active View is also indicated in the application title

line.

Om

T  Sarvgla 168421140
Deaceptan®:  svwal Ganet 10X

Gabey

enrute Lang Exgonres
Aralspouis

T Whllenalance
Pt
Gwer. *
Blog: —
Write Sminace
* lnge
Garrng ——
Cortrapt
Teigtrens
Saturetan
Haa
g o Latawna Puss
16 51 pe Pand
T Misosaneous
Dorwsatry oo
Light soume.  Hwoges
T Conbperaton
4% Nrer

4% Mo

Luminance Controls

29 : B2 : 56 -

Use the horizontal sliders provided to control the camera’s Gain and Exposure settings.

Gain should be kept to a low value whenever possible. Camera models equipped with a CCD sensor require an
increased minimum gain setting (recommended 2.0 to 2.5, for most INFINITY2, 3, and 4 series cameras), while a
gain of 1.0 is recommended for the CMOS sensor-equipped INFINITY 1 series camera models.

Use the Exposure slider to control the intensity of the image displayed from the camera. A bright light source
and short exposure time allows the camera to operate at the fastest frame refresh rates. Enable the Auto
Exposure check box to allow the application to automatically adjust the exposure time in response to changes in
the light level, as occurs when switching between microscope objectives. When the Auto Exposure option is



selected, the Target scene brightness is specified using the horizontal slider. Values for the Target are specified
between 0 and 100% of maximum brightness. There is a setting that allows the software to simulate long
exposure times. When enabled, this setting limits the camera to a maximum of 500ms in real exposure time,
and then digitally stretches the image output to simulate the requested exposure. A captured image will use the
exposure time indicated, and the digital stretch is not applied in the result.

White Balance Controls

The camera’s ability to provide accurate output color is based primarily on its response to the light source being
used. The application software must set the camera’s individual Red, Green, and Blue color gains to provide an
image where the background is not tinted (ie.: white or grey). Ensure that the live image is not over-exposed — a
safe technique to employ is to enable Auto Exposure with a target brightness value between 50 and 70, but with
experience it will be possible to set an appropriate value using the manual Exposure slider. To perform the
white balance operation, remove the sample from the field of view. If using a reflected light source (typically a
stereoscope), then place a white or grey card in the field of view. Click on the White Balance button.

As long as the lamp power adjustment remains unchanged, the camera’s white balance should hold true. When
lamp intensity is adjusted (eg.: halogen bulb), the proportion of Red, Green, and Blue present in the light source
is altered, and the camera White Balance must be performed to accommodate the change. For many new (LED)
light sources, the intensity of the light can be adjusted while preserving the color temperature, making fewer
white balance operations necessary with lamp setting adjustments.

If the results of the Auto White Balance operation are unsatisfactory for your requirements, it is possible to
make manual alterations to the settings for each of the Red, Green, and Blue color channel gains using the
sliders provided.

Image Controls

The Image control parameters allow for further adjustment to the results. Lumenera recommends that the
values for Contrast, Brightness, and Hue remain unaltered from their default settings (Contrast = 1, Brightness =
0, Hue =0). The value for Gamma can be increased for an older CRT monitor, but is more commonly left at 0 for
new monitors, as dark areas in the image are well represented. When the camera is used to image metallic
substances, such as copper, brass, silver, gold, bronze, etc., it can be beneficial to increase the Saturation value
up as high as 50. The saturation control is ordinarily left near 0, but will make colors appear more vivid if it is
increased slightly. To render the output of a color camera as monochrome, reduce the Saturation slider value to
the minimum.

The option to Highlight Saturated Pixels will produce a coloured overlay on any pixels that reach maximum
brightness. The option to Enable 16-bit output will result in a reduced frame rate out from the camera, while
the range of pixel intensities in the saved image will be increased from 8-bit to either 10, 12, or 14-bit,
depending on what the camera model supports. Images must be exported into a TIFF format to make use of the
16-bit file format. There is no discernible difference in the live video preview when the Enable 16-bit option is
selected, as the monitor can only display 8-bits per channel (RGB-24).

Miscellaneous Controls

Use the controls in this section to adjust the image output. The Demosaicing method is selected by means of a
dropdown menu. The selected option is used to identify how the raw image data is converted into a full colour
image by the application. More CPU processing is required to support the better output quality options, but on



most computers there will not be a noticeable drop in frame rate. This same setting will dictate the level of de-
mosaicing that is applied to the captured images. Unless a performance problem with the live preview is
observed, the best image quality should be used.

Choose a Light Source that matches the lamp type used on your microscope, or the effective illumination type
that is produced by the light in conjunction with any optical filters that are in the light path. For example, if a
Daylight (blue) filter is in position with a Halogen lamp, the most suitable light source to choose would be
Daylight. It is not necessary to match the Light Source to your specific lamp type, but it is more important to
experiment with the options to determine which setting provides the most accurate colour response for your
configuration.

Use the X Mirror and Y Mirror options to cause the image from the camera to be inverted, if necessary. Some
microscope optics for the camera port will have an image that is inverted when compared against that produced
in the oculars. With the camera’s USB cable positioned away from the oculars, select either to have both the X
& Y Mirror options enabled, or disabled. The image will either be right-side up or upside down on your monitor,
depending on how you invoke these two settings.

General Controls

Fields are provided to allow for an optional Prefix Title to be applied to each image stored in the image
database. By default, the application generates a unique ID for each captured image. Providing a Prefix name
facilitates searching and organizing images when they are in the database, but it is not necessary to supply a
Prefix. Descriptive text can also be entered and is stored with each image in the database.

It is also an option to direct captured images to be stored in any existing Gallery in the image database. The use
of named Galleries is optional, but may help with the search and retrieval of images from the database at a later
time. Gallery creation is handled within the Browser View and is described later in this document. All existing
Gallery names used in the database are accessible from the dropdown list presented in the General Controls.
The selected Gallery name becomes the Active Gallery where images will be grouped.

INFINITY ANALYZE uses named Presets to retain information about camera settings and calibration data for easy
retrieval. ldeally, one or more Presets would be created and saved for each magnification used on the
microscope. If each objective is used at times with different color filters, or other optical components, then the
ability to save Presets with specific names makes selecting and restoring the camera settings an easy operation.

Preset: 40X

Ak

Reset to Defaults

Calibration: Set Scale

El

Use the ( ) icon to the right of the Preset dropdown list, to invoke the Preset Editor. To create
a new named Preset, use the Preset Manager panel to provide a name and description for a new Preset. Use
the icons on the lower left side of the Preset Manager panel to remove unwanted Presets, or to add a new line
for another Preset. Note that a Preset can only be deleted if there are no images stored in the database
(Galleries) that are using that Preset. Be sure to name Presets accordingly, so that the appropriate objective
(magnification) is positioned by the operator when a specific Preset is active. Activate a specific Preset on the



list by highlighting it and clicking on the curved arrow icon adjacent to the “+” and “-“ buttons on the Preset

Manager dialog.

Preset Manager

_ Title . Description
40X Halogen w/daylight filter
10X Halogen - no filter

When a new Preset is created and activated, the Calibration -> Set Scale button can be used to associate a scale
with the Preset. A Captured image will be displayed in a new Window.

Use the Zoom control (“+”, “=”, “-“) in the lower right of the new Window, along with the scroll bars on the right
and bottom edges, to locate an area of the image containing an object of known dimensions, or the intervals on
a stage micrometer or ruler. Click the mouse on the image and drag a line of suitable length over the image.
Specify the length and the units in the field at the bottom of the window. Close the window to complete the

Calibration. Prior to pressing the “Save” button, the measurement line can simply be dragged again. If an error



is made with the length specified and the “Save button has already been clicked, then the active Preset must be

deleted and a new one created, repeating the step Calibration -> Set Scale.

Any images acquired form the camera when the Preset is active, will have the Calibration information associated
with it. Measurements can be taken from these images using the tools available in the Process View. Be certain
to change to the appropriate Preset each time the microscope magnification is adjusted, prior to capturing any
images. It is not possible to alter the calibration for an image after it has been captured to the database.

Image Acquisition

Use the Camera icon in the upper left corner of the window to capture an image. The status window in the top
center of the application will update briefly to indicate that an image acquisition is in progress. Other than that
message, there will be no other indication and no interruption to your process of acquiring images in to the

database.
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Browser View

The application stores all captured images in an internal database, using a unique date/time stamp for file name,
combined with the optional prefix. Captured images are also associated with the particular Gallery name that
was active at the time the image was acquired. The Browser View provides thumbnail representations of the
stored images. Use the Browser View to search images, select an image for Export, or to select an image to
open in the Process View.
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Thumbnail images displayed in the Gallery can be sized using the zoom control in the lower right corner of the
application window. Each thumbnail is displayed with the image name at the base, and the image is
represented with a two-tone shaded diagonal division. Click and drag on any thumbnail to re-organize the order
of presentation.

Use the fields displayed in the left panel to preview only those images belonging to a specific Gallery, or
matching a specific Date/Time criteria for acquisition.

Create a new Gallery using the Plus (+) icon in the lower left corner of the Application window. A Gallery can be
removed from the database by clicking the Minus (-) icon in the lower left corner of the Application window.
Once a Gallery has been deleted, the images in the database remain stored, but are no longer grouped within
the gallery, and can only be retrieved by date. Note: There is currently no warning prompt before a gallery is
removed, and this operation cannot be un-done.

Double-click on any thumbnail image to cause the Application to switch to the Process View with the selected
image displayed.



Process View

The application provides tools for adding Annotation objects on captured images. If an image is acquired when
a calibration Preset includes a scale reference, then the Annotation tools can be used in Measure Mode to take
accurate measurements on the image. Measurements are stored in tabular format and can be exported to a

spreadsheet. Annotations and Measurements are stored automatically with the image and will be included in
the output file as the image is exported.
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Annotation & Measurement Controls

The tools for adding annotation objects and for taking measurements are accessible at the top of the Application
just above the image. If the displayed image was captured while a calibrated Preset was enabled, then the
Measure Mode button will be accessible — otherwise, the Measure Mode button is disabled.

N I Measure Mode

The icons on the Annotation Toolbar include: Selection Pointer, Line, Rectangle, Ellipse, Polygon, Text, and
Arrow. Each function is invoked by clicking on the appropriate icon, which remains active until another function
is chosen. Annotation objects appear on the image as the user clicks and drags to define vertices. When the



Measure Mode is disabled, annotations are displayed graphically, without associated text. When the Measure
Mode is active, an associated text record is displayed on the image showing the measurement parameters
related to the function being used.

Circles and squares will be produced by holding down the Shift key while performing a mouse drag operation
with either the ellipse function or the rectangle drawing functions invoked, respectively.

Panel Display Functions
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The three buttons shown above are used to switch between panels on the left side of the Process View. Access
to the tabular data for measurement records is obtained by selecting the middle button; the left button enables
the Graphic controls panel. Presently, the right button is unassigned.

E | olle
Type Unit | Width/Length Height Area
Circle pm 117.901 92.637 8578.111
Line um 114.946
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|

When the Measurement panel is displayed, the table headings indicate the Type of measurement, the Units,
Width/Length, Height, and Area measurements where applicable, based on the type of measurements taken on
the calibrated image.

Image Details
The image name is displayed, along with the name of the Preset that was active when the image was acquired.
Grid Controls

Two options are available to control the visibility of the grid overlay, and whether annotation objects are to be
snapped to the vertices of the grid when they are placed. Grid spacing is controlled by use of the slider control,
and clicking on the Color button will produce the multi-function palette control for identifying the color of the
grid.

Graphic Controls

Use the available options to specify whether lines are represented, and whether a polygon fill color is applied.
Each option has a Color button which displays the multi-function palette control to make color selections. The
line width is controlled using the horizontal slider, and the numerical field.



Dimension Details

Information on the dimensions of each graphic object is shown in the panel on the left. These dimensions are in
pixels. The length dimensions for each object are displayed on the image for any objects placed using Measure
Mode.

Font Controls

Click on the letter ‘A’ displayed in this control, to invoke the Font Parameter control window. Options are
available in to adjust the Font style, Name, Size, and Color.

I>|#®« 1 [+

Conceroii Farsily Typeface
All Foms Charcoal T S
Englisk Cochin akic
Favorites Comic Sans M5 Boid
Recertly Used Copperplate Bl b
Fixed Width Corsiva Hebrew

Fun Courier

Modern Courier New

New-1 Cracked

POF Damascus

Q

Image Export

The ability to Export images is available from the Process View (in addition to being available from the Browser
View). Use the button on the right side to invoke the Export dialog.
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Images may also be Exported using the Menu bar at the top of the monitor, when the INFINITY ANALYZE
application is active. NOTE: Bulk image export can no longer be accomplished using drag & drop, since the
release of the Mojave OSX. Using Drag & Drop operations under Mojave result in images being permanently
removed from the ANALYZE browser. To achieve multiple image export in the Browser view, select the desired
images and then choose Edit -> Copy (#8C) in the ANALYZE menu bar. Navigate to the desired Finder window
destination folder and choose Edit -> Paste ## items (38V) in the Finder menu bar, to paste copies of the
selected images as TIF files in the destination folder. Images can then be renamed to have the desired file
names.
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The available image export formats are:

o Adobe PDF (graphic overlays are represented as vectors in a PDF, for clean scaling)

e Bitmap
e TIFF
e JPEG

e PNG



